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Introducing Badia FullMeasure XT 2.0

Badia FullMeasure XT 2.0 is an XTensions module for Mac OS QuarkXPress 4

that expands the Measurements palette to include additional text and 

paragraph attributes, picture information, item and frame characteristics,

common preferences, guide placement and several other new features. 

The FullMeasure palette looks and operates much in the same way as the

Measurements does. In fact, this new palette is attached to the Measurements

palette on the right and moves along with it. As a result, there’s no need to

add new menu entries or keyboard commands – FullMeasure really “extends”

the Measurements palette.

The information displayed in the FullMeasure palette is grouped in six 

different categories or modes that reflect the user’s current selection:

• Text Mode – Displayed when text within a box is selected with the 

Content tool .

• Text Path Mode – Displayed when text in a path is selected with the 

Content tool.

• Picture Mode – Displayed when a picture is selected with the Content tool.

• Box Mode – Displayed when a box is selected with the Item tool .

• Line Mode – Displayed when a line is selected with the Item tool.

• Guides Mode – Displayed when no object is selected with either the Content

or the Item tool.
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The modes change automatically when a tool or the selection changes. You

can switch temporarily to the Box or Line mode by holding the control

key, and to the Guides mode by holding both the control and option keys:

+

+

Temporary modes are displayed when you hold the control and control + option keys

Most of the fields in the FullMeasure palette can be edited in the same way

as the fields in the Measurements palette. For numerical fields, you can

always enter math expressions, such as 2p4 + 5"/6. You can undo any key-

stroke within an editable field by pressing 1Z, or you can press 1. to revert

to the old setting and exit the palette. To apply any changes, press the return

or enter keys, or press the tab key to jump to the next editable field.

Several fields host a pop-up menu ( ), either indicating that a selection 

can be made from a list of options (for example, when choosing a color) or

displaying additional information (for example, guide positions). Entries

that have information only are grayed out.

Two different kinds of pop-up menus: 
one for a list of options and one for information only.

Editable fields that have a pop-up menu attached are also type-and-resolve

fields – you can type the first few letters of a possible entry and the full

name will be revealed. The color and vertical justification fields are examples

of type-and-resolve fields.

A type-and-resolve field. 
In this case, just typing an “M” reveals the full color name.
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FullMeasure allows you to undo and redo text, paragraph and item changes

just in the way you might expect it to. Press 1Z or select Edit->Undo

from the Edit menu. Press 1Z again to redo the operation. Changes to 

preferences, views or guide settings are not undoable.

As stated before, the FullMeasure palette moves with the Measurements

palette. To hide/show FullMeasure, hide/show the Measurements palette

(F9 or View->Hide/Show Measurements ). A description of the

information displayed for each mode follows.

The FullMeasure Palette in Text and Text Path Modes

When a range of text is selected with the Content tool , several 

additional text and paragraph attributes are shown, along with specific 

text box or text path information.

If the selection contains different instances of the same attribute (for 

example, different baseline shifts), the corresponding field will be empty.

However, you can enter a new uniform value by clicking and then 

typing in that field.

Here are the possible choices for each of the pop-up menus:

Type Color Text Box Text Path Text Path
Vertical Alignment Orientation Alignment
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Horizontal /
Vertical Scale

Baseline Shift Paragraph
First Indent

Paragraph 
Space After

Paragraph
Left Indent

Paragraph
Right Indent

Text Box 
Vertical Alignment

Type Shade
Text Box 

Inset

Type Color
Paragraph

Space Before

Text Path 
Orientation

Text Path
Alignment



The FullMeasure Palette in Picture Mode

When you select a picture with the Content tool, a variety of picture and

picture file information is displayed. The FullMeasure palette also contains

tools for greeking individual pictures, for fitting the box to the picture, 

for opening the picture with the creator application and for revealing the 

enclosing folders of the linked image file in the Mac OS Finder.

To greek the picture currently selected, click on the icon (you must 

deselect the picture to see the results). The button icon changes to a closed

eye icon: . Click again to ungreek it. 

The picture full path pop-up menu shows the name of the linked image as

well as those of its enclosing folders. If you release the mouse when a folder

(or even the picture name) is selected, FullMeasure will reveal and select

that item in the Finder.

You can highlight the picture icon in the Mac OS Finder by releasing the mouse 
in the top row of the full path pop-up menu.
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Picture

File Size Picture Model Picture Status /
Open Picture 

Usage Window

Number and List of
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Picture Type
Picture

Resolution
Align Picture /

Fit Box to Picture

Picture 
Full Path

Open Creator
or Open with
Application

Picture Name

Creator
Application

Number and List of
Embedded Fonts



Release the mouse in any row of this pop-up menu to highlight and select 
in the Finder any of the picture enclosing folders.

Note: If a picture is missing, its full path will be grayed out.

The picture type is shown as in the Picture Usage window. For DCS files,

FullMeasure displays “EPS DCS” in the picture type field. 

FullMeasure uses Adobe Photoshop™ standards when referring to 

the picture model. Thus the possible values are: Bitmap, Gray Scale, 

Duotone, Lab Color, Indexed Color, RGB, CMYK and Multichannel 

(for EPS DCS 2.0 files).

The creator application is the default application that the Mac OS Finder

associates with a given file (as shown in the Kind column when viewing a

folder as a list). To launch this program and open the currently selected 

picture, choose Open from the creator application pop-up menu:

To open the picture with an application other than the default creator,

choose Open with. The following dialog allows you to browse and select

the application:
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Once you select the application, it will be launched, brought to the front,

and the picture will be opened with it.

The picture resolution is always displayed in dots per inch (dpi).

Note: FullMeasure can recognize the picture model and resolution of any 

TIFF file (Mac OS and PC platforms), and EPS files created with Adobe

Photoshop™. All other file types are not currently supported.

The picture status is also displayed in FullMeasure. You can click anywhere

within the status area to open the Picture Usage window.

Click in the picture status area to open the Picture Usage window. 

FullMeasure also gives you a powerful tool for aligning a picture within the

picture box and for fitting the box to the boundaries of the picture. Click 

on the pop-up menu beside the icon:

Unlike some other XTensions, FullMeasure takes into account any scale or

skew applied to the picture and/or the picture box. As well, when fitting the

box to a picture, FullMeasure can move any side of the box, so that the 

picture always remains in its original position in the page. And if you are 

not satisfied with the result, just press 1Z to undo the operation.

FullMeasure fits the box to a picture without changing 
the physical location of the picture in the page.
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For files of EPS type, FullMeasure displays the number of fonts and custom

colors embedded within the file (if any), along with a list of their names:

A list of EPS fonts A list of EPS custom colors

A question mark (?) is shown when a value for a certain field cannot be

determined, or if an error occurs. A dash (–) indicates either zero (the fonts

in an TIFF file, for example) or not applicable (the resolution in a vector 

EPS file, for example).

If a picture box is empty, the message “Empty Picture Box” is displayed in

the picture name field. If there’s no linked image, “No Disk File” is shown.

The FullMeasure Palette in Box and Line Modes

Selecting an item with the Item tool causes the FullMeasure palette to

display item characteristics. Depending of whether it’s a box or a line, one of

the following palettes will appear:

The FullMeasure palette in Box mode
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Skew

Corner 
Radius

Runaround
Type

Frame ColorShape

Frame Shade

Background
Shade Frame Width

Background
Color Frame Style



The FullMeasure palette in Line mode

Some of the information shown is common to both boxes and lines, 

with the exception of corner radius and frame attributes, which are only

applicable to boxes. As well, line skew is only available for Bézier lines. 

Although corner radius is already part of the Measurements palette,

QuarkXPress does not show this attribute for boxes of text or no contents

(None), only for picture boxes. FullMeasure can show it for any kind 

of boxes.

Note: For items with no contents (None), the Box or Line mode is always

shown, with either the Content or Item tools.

Tip: Although FullMeasure does not display information when a group of

items is selected, you can still get box or line information for individual items

that are part of the group by selecting the item with the Content tool 

and pressing the control key.

Here are the contents of the new pop-up menus (color menus are 

not shown):

Runaround Type Shape Frame Style

Note 1: The frame style field is not a type-and-resolve field.

Note 2: For picture box runaround, you can only choose the None, Item or

Auto Image types with FullMeasure.
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The FullMeasure Palette in Guides Mode

The last mode that FullMeasure can display is the Guides mode, presented

when a document is open, the Content or Item tool is chosen, 

and no QuarkXPress object is selected. Several preferences, views and guide

settings are shown. 

To change the horizontal or vertical measure units, type a unit in the 

corresponding field or use their respective pop-up menus. You can lock or

unlock the horizontal and vertical measure units by clicking on the icon 

that connects the two fields. A icon indicates that the units are locked –

that is, changing the horizontal units will also change the vertical ones (the

vertical units field and pop-up are displayed grayed out), whereas a icon

indicates that the units are unlocked. 

The possible units that you can choose from are:

The view pop-up menu offers preset views, plus an additional feature that

allows you to save the current view for future use. Custom views are added

at the end of the list and they remain available until you quit QuarkXPress.
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Hide/Show
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View
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Current 
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Number and List of
Horizontal Guides

Greek/Ungreek
All Pictures Preset Views



The standard view pop-up menu The view pop-up menu after several
with preset options custom views were added using the

Add Current View feature

Note: The view field is not a type-and-resolve field.

The view increment is the preference setting that determines the amount

added to or subtracted from the view scale when using the Zoom tool .

FullMeasure also shows you the total number of horizontal and vertical

page and spread guides. To view the exact position of each rule, click on the

pop-up menus to the right of the respective fields.

Page guides are shown at the top of the list, followed by spread guides.

Horizontal rules are listed from top to bottom and vertical rules from left to

right. Values displayed are always measured from the top left corner of 

the page, regardless of the location of the ruler origin.

A unique feature of FullMeasure allows you to place guides at a specified

location, and also to step and repeat guides. You do this by choosing the

Add option. The following dialog appears:
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Enter an appropriate value in the Position field and select whether you

wish to add a page or a spread guide. Click Apply to test the result, OKto

add the guide or Cancel to close the dialog without adding any guide. As

mentioned before, values are measured from the top left corner of the page.

To step and repeat guides, click the Repeat check button. Two new fields

become available. The first field contains the number of steps; the second

one, the gap or distance between guides. The first guide will be placed at 

the location indicated in the Position field, followed by as many guides

as indicated in the Repeat field.

In this example, the horizontal page guides will be placed at the following

positions: 3.75", 4", 4.25",... 6.25". 



After you click OK, you can open the horizontal guides pop-up menu. It may

look something like this:

Note: You cannot add single page or spread guides that fall outside the

appropriate boundary limits. However, when step and repeating guides,

FullMeasure will place as many guides as it can, without reporting any error

for the ones that cannot be placed.

If you have any questions, or would like to comment about FullMeasure XT, 

please visit our web site at www.badiasoftware.com or send us an e-mail at

info@badiasoftware.com
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